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SSH->Auth->Credentials

PuTTY
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~$ cp ./dd-23-13-01 ~/.ssh/

~$ chmod 600 ~/.ssh/dd-23-13-01

~$ ssh -i ~/.ssh/dd-23-13-01 dd-23-13-01@login1.karolina.it4i.cz
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Molecular Docking

Pose – a possible relative orientation
of a ligand and a receptor as well as
conformation of a ligand and a
receptor when they are form complex

Score – the 
strength of

binding of the 
ligand and the

receptor.

IC50: 8.9 (nM)
Score (Vina): -9.9 

PDB: 1KE7
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https://github.com/ci-lab-cz/docking-scripts

Automated scripts for Molecular Docking
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https://github.com/ci-lab-cz/docking-scripts

Automated scripts for Molecular Docking
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Output SQLite DB
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1KE61KE5 1KE7

560 nM 5.7 nM

CYCLIN-DEPENDENT 
KINASE 2 (CDK2)

 8.9 nM



Automated scripts for Molecular Docking

ssh -i ~/.ssh/dd-23-13-01 dd-23-13-01@login1.karolina.it4i.cz

mkdir docking_tutorial
cd docking_tutorial
cp 
/mnt/proj2/dd-23-13/docking_tutorial/{ligands_pH74.smi,protein_prepared.pdbqt,config.txt} .

qsub -A DD-23-13 -v 
input=$(pwd)/ligands.smi,protein=$(pwd)/protein_prepared.pdbqt,config=$(pwd)/config.txt   
/mnt/proj2/dd-23-13/script_vina.pbs
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Prepare docked molecules for MD

module load Anaconda3
source activate gmxMMPBSA

python /mnt/proj2/dd-23-13/md-scripts/scripts/sdf2mols.py -i 
docking_tutorial/ligands_pH74_protein_prepared_docking_vina_output.sdf -o 
docking_tutorial/mols
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High-throughput MD



ssh -i ~/.ssh/dd-23-13-01 dd-23-13-01@login1.karolina.it4i.cz

mkdir md_tutorial
cd md_tutorial
cp /mnt/proj2/dd-23-13/md_tutorial/{protein_prepared.pdb,ligand.mol} .

qsub -A DD-23-13 -v 
lfile=$(pwd)/ligand.mol,pfile=$(pwd)/protein_prepared.pdb,script_path=/mnt/proj2/dd-23-13/md-scripts/scripts
/,wdir=ligand_01ns,mdtime=0.1,gromacs_version='GROMACS/2021.4-foss-2020b-PLUMED-2.7.3'  
/mnt/proj2/dd-23-13/md-scripts/Protein-Ligand_MD_PBGBSA/01_complex_preparation_md.pbs

in case of multiple ligands:
 for i in mols/*.mol;do fname=${i##*/}; name=${fname%.*}; echo $i; qsub -A DD-23-13 -v 
lfile=$(pwd)/$i,pfile=$(pwd)/protein_prepared.pdb,script_path=/mnt/proj2/dd-23-13/md-scripts/scripts/,wdir=$(
pwd)/$name,mdtime=0.1,gromacs_version='GROMACS/2021.4-foss-2020b-PLUMED-2.7.3'  
/mnt/proj2/dd-23-13/md-scripts/Protein-Ligand_MD_PBGBSA/01_complex_preparation_md.pbs;done

Run MD simulation by one command:
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Molecular dynamics

● to explore conformational space
● to explore biological process of 

molecular recognition
● to investigate ligand pose stability
● to estimate binding affinity of 

protein-ligand complexes

1. MD simulations mimic the physical motions of 
atoms present in the actual environment;

2. The atoms and molecules are allowed to interact 
for a fixed period of time, giving a view of the 
dynamic "evolution" of the system.

https://doi.org/10.1016/j.str.2017.02.009
13

https://doi.org/10.1016/j.str.2017.02.009


What can be done by MD

● To explore different conformation of protein
○ To investigate internal-flexibility of protein
○ For practical use we select conformations from the most populated clusters of all 

conformations 

Conformation can be used:
- for further molecular docking studyPDB: 1W51
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What can be done by MD

● To explore stability of ligand pose

MD 10ns.
Ligand goes out 

of site

Example of incorrect 
protonation and pose:

PDB: 2WEH

Up to 2 A

15

x-ray

docking



What can be done by MD

● to estimate binding affinity of protein-ligand 
complexes

○ GBSA/PBSA approach

Valdés-Tresanco, M.S., Valdés-Tresanco, M.E., Valiente, P.A. and Moreno E. gmx_MMPBSA: A New Tool to Perform End-State Free Energy Calculations 
with GROMACS. Journal of Chemical Theory and Computation, 2021 17 (10), 6281-6291. https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645. 
MMPBSA.py: An Efficient Program for End-State Free Energy Calculations  Bill R. Miller III, T. Dwight McGee Jr., Jason M. Swails, Nadine Homeyer, 
Holger Gohlke, and Adrian E. Roitberg  Journal of Chemical Theory and Computation 2012 8 (9), 3314-3321 DOI: 10.1021/ct300418h

Correlation between MM-GBSA 
predicted and experimental 

binding free energy. 

Yang T, Wu JC, Yan C, Wang Y, Luo R, Gonzales MB, Dalby KN, Ren P. Virtual screening using molecular simulations. Proteins. 2011 Jun;79(6):1940-51. doi: 
10.1002/prot.23018. Epub 2011 Apr 12. PMID: 21491494; PMCID: PMC3092865.
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https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645


What can be done by MD

● to investigate protein-ligand 
interaction stability

17

Bouysset, C., Fiorucci, S. ProLIF: a library to encode 
molecular interactions as fingerprints.
J Cheminform 13, 72 (2021). 
https://doi.org/10.1186/s13321-021-00548-6



Aim: to implement an easy to use tool to run whole pipeline of 
Molecular Dynamics simulation automatically  

Structure Preparation
● add missing atoms
● protonation
● etc

Force-field
● Definitions of inter-atomic bonded and 

non-bonded forces

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● 100 ps

NVT and NPT equilibration
● 1000 ps

Product Simulation

Analysis

Preprocessing

Pre-simulation 
steps

Perform High-Throughput Molecular Dynamics

Rank compounds by:
● Stability of previously obtained pose of ligand
● Calculated Binding Energy
● Stability of protein-ligand contacts 18



The tool is already implemented 
and free available

https://github.com/ci-lab-cz/md-scripts/tree/master/Protein-Ligand_MD_PBGBSA

Command: qsub -v lfile=ligand.mol,pfile=protein.pdb,script_path=/scripts,wdir=ligand_protein_1ns,mdtime=1 01_complex_preparation_md.pbs
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Main features of the tool:
● User control of simulation time 

○ from 10 ps to 1 µs

● Default preset optimal parameters to run Molecular Dynamics

○ can be easily modified

○ useful as teaching source 

● Support of modeling of different molecular systems

○ protein only, protein-ligand, protein-ligand-cofactor

● Automatic analysis of simulation:

○ RMSD plots for both protein and ligand objects

○ Plot of flexibility of each amino acids (RMSF)

● Support of analysis by additional instruments:

○ ProLIF: Ligand-Protein interactions (time-dependent function, stability analysis)

○ MM(PB)GBSA: Calculation of Binding Energy

Protein

Protein-Ligand

Protein-Ligand-Cofactor20
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Classical Molecular Dynamics

22

Structure Preparation

Force-field
● Definitions of inter-atomic bonded and 

no-bonded forces (ligand and protein)

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● 100 ps
● to ensure that the system has no steric 

clashes or inappropriate geometry

NVT and NPT equilibration
● 1000 ps
● equilibrate the solvent and ions around the 

protein

Product Simulation

Analysis

Pre-simulation 
steps

Preprocessing



Protein preparation

23
https://www.cgl.ucsf.edu/chimera/



Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

https://www.rcsb.org/


Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

2. Download sequence from PDB or from UniProt

Download Files -> Fasta Sequence

https://www.rcsb.org/


Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

2. Download sequence from PDB or from UniProt

Download Files -> Fasta Sequence

3. Save smiles of ligand into file (ligand.smi)

https://www.rcsb.org/


Protein preparation
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4. Open Fasta and PDB in Chimera

a. Dock Prepare

Structure Editing -> Dock Prep



Protein preparation
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4. Open Fasta and PDB in Chimera

b. fill missing loops by Modeller

Tools -> Sequence -> Sequence

Sequence -> Structure -> Modeller (loops/refinement)

c. add Hs to selected model

select the model with 
the lowest zDOPE



Protein preparation
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4. Open Fasta and PDB in Chimera

d. Set HIS protonated state

Tools -> General Controls -> Command line

Put in the Command line:

setattr r type HID :HIS@HD1,DD1,TD1,HND
setattr r type HIP :HID@HE2,DE2,TE2
setattr r type HIE :HIS@HE2

https://ambermd.org/Questions/HIS.html

HIS84 HIE84

check visually active site



Chimera preparation
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4. Open Fasta and PDB in Chimera

e. Save protein only (plus ions, metals) and ligand only in pdb formats separately

Select -> Residue -> Ligand_id

File -> Save PDB -> Save selected only

ligand.pdb

Select -> Invert (all models)

File -> Save PDB -> Save selected only

protein_prepared.pdb



Ligand preparation
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5. Save protonated smiles (pH 7.4) by Marvin into ligand_74.smi

Open Marvin Sketch

File -> Open -> ligand.smi

Calculations -> Protonation -> Major Microspecies -> 7.4 -> Ctrl+L (copy as Smiles)

Save to ligand_74.smi



Ligand preparation
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6. Transform pdb of ligand into mol format (add bonds information from smiles)

Script https://github.com/ci-lab-cz/md-scripts/blob/master/scripts/pdb2mol.py

Run in Bash/Shell: 

python md-scripts/scripts/pdb2mol.py -i ligand.pdb --smiles ligand_74.smi  -o ligand.mol

https://github.com/ci-lab-cz/md-scripts/blob/master/scripts/pdb2mol.py


Protein Ligand preparation
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Input Files for MD:

protein_prepared.pdb

- no missing non-terminal atoms/residues
- removed non-protein residues
- added all hydrogens
- set HID/HIE/HIP states

ligand.mol

- protonated at 7.4 pH
- added all hydrogens



Classical Molecular Dynamics
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Structure Preparation

Force-field
● Definitions of inter-atomic bonded and 

no-bonded forces (ligand and protein)

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● 100 ps
● to ensure that the system has no steric 

clashes or inappropriate geometry

NVT and NPT equilibration
● 1000 ps
● equilibrate the solvent and ions around the 

protein

Product Simulation

Analysis

Pre-simulation 
steps

Preprocessing

https://github.com/ci-lab-cz/md-scripts



Practice: force fields
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https://manual.gromacs.org/documentation/current/onlinehelp/gmx-pdb2gmx.html

New files:
protein.gro: a molecular 
structure in Gromos87 format.
topol.top: molecular topology
posre.itp: position restraints

gmx pdb2gmx -f protein.pdb -o protein.gro -water tip3p -ignh <<< “AMBER99SB-ILDN” 

Prepare the protein topology with pdb2gmx



Practice: force fields
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https://manual.gromacs.org/documentation/current/onlinehelp/gmx-pdb2gmx.html

gmx pdb2gmx -f protein.pdb -o protein.gro -water tip3p -ignh <<< “AMBER99SB-ILDN” 

Prepare the protein topology with pdb2gmx

pdb2gmx does not work on ligand



Automation tools for ligand topology
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Ligand Force fields

Prepare the ligand topology using external tools

antechamber -i ligand.pdb -fi pdb -o lig.mol2 -fo mol2 -c bcc -pf y -s 2
parmchk2 -i lig.mol2 -f mol2 -o lig.frcmod
python pmed_amb2gmx.py -p lig.prmtop -x lig.inpcrd -o UNL

Build the topology for the protein-ligand system
Insert a line that says #include lig.itp" into topol.top after the position restraint file is included
Make adjustments is in the [ molecules ] directive

38

New files: 
lig.mol2 - file of ligand with charges and bonds
lig.frcmod - Parameter modification file
posre_ligand.itp - positional restraints
ligand.gro - ligand in Gromos87 format
ligand.inpcrd - Amber coordinate file of ligand
ligand.prmtop - Amber topology file
ligand.top - Gromacs topology file

Changed files: topol.top



Solvation
To perform simulation we should add water molecules to mimic real environment.

There are two steps to defining the box and filling it with solvent:

1) Define the box dimensions using the editconf module
2) Fill the box with water using the solvate module.

We will use a simple cubic box as the unit cell.
First define the box using editconf:
    gmx editconf -f protein.gro -o protein_newbox.gro -c -d 1.0 -bt cubic

a solute-box distance of 1.0 nm will mean that there are at least 2.0 nm between any two periodic images 
of a protein. This distance should be sufficient for just about any cutoff scheme commonly used in 
simulations.
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New files: 
protein_newbox.gro: protein+box system



Solvation
To perform simulation we should add water molecules to mimic real environment.

On the previous step we have defined a box, then we should fill it with solvent (water). Solvation is 
accomplished using solvate command:

gmx solvate -cp protein_newbox.gro -cs spc216.gro -o protein_solv.gro -p topol.top

-cp - the configuration of the protein (-cp)

-cs - the configuration of the solvent (-cs)

spc216.gro is a generic equilibrated 3-point solvent model (suitable for SPC, SPC/E, or TIP3P water, 
since they are all three-point water models)
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New files: 
protein_solv.gro: protein + solvent system
Changed files: 
topol.top



Adding ions

We need to add ions of CL- or NA+ to neutralize our protein:

     gmx grompp -f ions.mdp -c protein_solv.gro -p topol.top -o ions.tpr

     gmx genion -s ions.tpr -o protein_solv_ions.gro -p topol.top -pname NA -nname CL -neutral

41

Solvated protein with ions
New files: 
protein_solv_ions.gro: protein + solvent + 
ions system
ions.tpr: portable binary run input file. This 
file contains the starting structure, the 
molecular topology and all the simulation 
parameters. 

Changed files: topol.top



Energy minimization

Before we can begin dynamics, we must ensure that the system has no steric clashes or inappropriate 
geometry (equilibrium state). The structure is relaxed through a process called energy minimization 
(EM).

Prepare files:

 gmx grompp -f minim.mdp -c protein_solv_ions.gro -p topol.top -o  em.tpr

Run the minimization:

 gmx mdrun -v -deffnm em –s em.tpr

42

New files: 
em.log: ASCII-text log file of the EM process
em.edr: Binary energy file
em.tpr: Contains the starting structure, the molecular topology and all the simulation parameters.
em.trr: Binary full-precision trajectory
em.gro: Energy-minimized structure



How to do an analysis:
The em.edr file contains all of the energy terms that GROMACS collects during 
EM. You can analyze any .edr file using the GROMACS energy module:

gmx energy -f em.edr -o potential.xvg << "Potential" 

43

Energy minimization



Equilibration

Energy Minimization ensured that we have a reasonable starting structure, but to 
begin real dynamics, we must equilibrate the solvent and ions around the protein.
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Why do we need equilibration?

If we were to attempt unrestrained dynamics at this point, the system may collapse.

 The reason is that the solvent is mostly optimized within itself, and not necessarily with the 
solute. It needs to be brought to the temperature we wish to simulate and establish the 
proper orientation around the solute (the protein). After we achieved the correct temperature 
(based on kinetic energies), we will apply pressure to the system until it reaches the proper 
density.
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Controlling the system

46https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf



Restrain the system

To equilibrate the solvent and ions around the protein we need to apply position 
restraints on the heavy atoms of the protein.

The purpose of posre.itp is to apply a position restraining force on the heavy 
atoms of the protein (anything that is not a hydrogen). Movement is permitted, but 
only after overcoming a substantial energy penalty.

47



NVT equilibration

48https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf

In MD simulation: some state variables 
are external parameters, others are 
observables to be calculated



NVT equilibration

to run NVT equlibration:

gmx grompp -f nvt.mdp -c em.gro -r em.gro -p topol.top -o nvt.tpr 

gmx mdrun -deffnm nvt -s nvt.tpr

An analysis:

gmx energy -f nvt.edr -o temperature.xvg <<< “Temperature”

49

New files: 
nvt.log: ASCII-text log file of the equilibration process
nvt.edr: Binary energy file
nvt.trr: Binary full-precision trajectory
nvt.gro: NVT-minimized structure



NPT equilibration

50https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf



NPT equilibration
Note that we are now including the -t flag to include the checkpoint file from the NVT equilibration

The coordinate file (-c) is the final output of the NVT simulation.

to run NPT equlibration:

gmx grompp -f npt.mdp -c nvt.gro -r nvt.gro -t nvt.cpt -p topol.top -o npt.tpr gmx mdrun -deffnm npt 
-s npt.tpr

An analysis:

    gmx energy -f npt.edr -o pressure.xvg <<< ”Pressure”

    gmx energy -f npt.edr -o density.xvg <<< “Density”
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New files: 
nvt.log: ASCII-text log file of the equilibration process
nvt.edr: Binary energy file
nvt.trr: Binary full-precision trajectory
nvt.gro: NVT-minimized structure



NPT equilibration

52In our tool we run 1000 ps NPT equilibration by default
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Periodic boundary conditions (PBCs) 
are a set of boundary conditions which 
are often chosen for approximating a 

large (infinite) system by using a small 
part called a unit cell. 

● PBCs are often used in computer 
simulations and mathematical models.

● The topology of two-dimensional PBC is 
equal to that of a world map of some 
video games; the geometry of the unit 
cell satisfies perfect two-dimensional 
tiling, and when an object passes 
through one side of the unit cell, it 
reappears on the opposite side with the 
same velocity.



Production MD
the system is now well-equilibrated at the desired temperature and pressure. We are now ready to release 
the position restraints and run production MD

We will run MD simulation

gmx grompp -f md.mdp -c npt.gro -t npt.cpt -p topol.top -o md_0_1.tpr

gmx mdrun -deffnm md_0_1 -s md_0_1.tpr

54

New files: 
md_0_1.tpr: portable binary run input file. It contains the starting structure of 
the simulation, the molecular topology and all the simulation parameters.
md_0_1.log: ASCII-text log file of the equilibration process
md_0_1.cpt: portable checkpoint file. The complete state of the simulation is 
stored in the checkpoint file, including extended thermostat/barostat variables, 
random number states and NMR time averaged data
md_0_1.edr: Binary energy file
md_0_1.xtc: Binary full-precision trajectory
md_0_1.gro: starting structure of the simulation in  



Analysis of calculated MD simulation

Remove PBC:

gmx trjconv -s md_out.tpr -f md_out.xtc -pbc nojump -o md_out_noj_noPBC.xtc <<< 
"System"

Center system:

gmx trjconv -s md_out.tpr -f md_out_noj_noPBC.xtc -o md_centermolsnoPBC.xtc -pbc mol 
-center -n index.ndx <<< "Protein_UNL System"

Alignment of all frames (Remove rotations and translations):
gmx trjconv -s md_out.tpr -f md_centermolsnoPBC.xtc -fit rot+trans -o md_fit.xtc -n index.ndx 
<<< "Protein_UNL System"
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RMSD:

gmx rms -s md_0_1.tpr -f md_0_1_noPBC.xtc -o rmsd.xvg -tu ns

 RMSF:

gmx rmsf -s md_0_1.tpr -f md_0_1_noPBC.xtc -o rmsf.xvg -oq rmsf.pdb -res

Analysis of calculated MD simulation

56

xmgrace



57

Output files:
md_out.tpr: portable binary run input file. It contains the starting structure of the simulation, the molecular topology and all the 
simulation parameters.
md_out.log: ASCII-text log file of the equilibration process
md_out.cpt: portable checkpoint file. The complete state of the simulation is stored in the checkpoint file, including extended 
thermostat/barostat variables, random number states and NMR time averaged data
md_out.edr: Binary energy file
md_out.xtc: Binary full-precision trajectory
md_out.gro: starting structure of the simulation

md_fit.xtc:  fitted trajectory (removed PBC and the rotation and translation, centered) to use for rmsd and energy calculation 
analysis
md_short_forcheck.xtc: fitted short trajectory (each 100 step is skipped)
frame.pdb: a frame from the trajectory to provide topology

MD trajectory analysis files:
rmsd.xvg - rmsd of Backbone of protein
rmsd_UNL.xvg - rmsd of the heavy atoms of ligand
gyrate.xvg - radius of gyration of the protein
rmsf.xvg - root mean square fluctuation of each amino acids

MD simulation by one command:
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Check your own MD trajectory

frame.pdb - a frame from the trajectory to provide topology 
md_fit.xtc - your fitted MD trajectory 



Analysis of calculated MD simulation

working dir: /home/user/MD_tutorial

Run on it4i cluster:
Visualize plots by xmgrace:
module load grace
cd ligand_01ns/
for i in *.xvg; do gracebat -hdevice PNG $i;done

Run analysis on your own computer:

scp -I path/to/your/private/key dd-23-13-XX@login1.karolina.it4i.cz:md_tutorial/ligand_01ns/{frame.pdb,md_fit.xtc, *.png} .

59
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Analysis of the calculated MD simulation

60



MMPBSA / MMGBSA
End-state free energy calculations 

with GROMACS files

61
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1) You can change ie_segment from 25 to 100

nano /mnt/proj2/dd-23-13/md-scripts/scripts/mmpbsa.in

2) run script for energy calculation:

qsub -A DD-22-13 -v tpr=md_out.tpr,xtc=md_fit.xtc,script_path=/mnt/proj2/dd-23-13/md-scripts/scripts/,wdir=ligand_01ns/,NP=11 
/mnt/proj2/dd-23-13/md-scripts/Protein-Ligand_MD_PBGBSA/02_pbsa.pbs

3) After calculation will be finished

cat ligand_01ns/FINAL_RESULTS_MMPBSA.dat

working dir: /home/user/md_tutorial
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For multiple molecules you can run other script to collect MM(P/G)BSA energies from all 
directories 

wdir=$(pwd)/md_tutorial bash 03_sum_result_pbsa.pbs



What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes
○ Molecular mechanics Poisson–Boltzmann 

surface area (MM/PBSA)
○ Molecular mechanics generalized Born surface 

area (MM/GBSA) 

Valdés-Tresanco, M.S., Valdés-Tresanco, M.E., Valiente, P.A. and Moreno E. gmx_MMPBSA: A New Tool to Perform End-State Free Energy Calculations 
with GROMACS. Journal of Chemical Theory and Computation, 2021 17 (10), 6281-6291. https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645. 
MMPBSA.py: An Efficient Program for End-State Free Energy Calculations  Bill R. Miller III, T. Dwight McGee Jr., Jason M. Swails, Nadine Homeyer, Holger 
Gohlke, and Adrian E. Roitberg  Journal of Chemical Theory and Computation 2012 8 (9), 3314-3321 DOI: 10.1021/ct300418h
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https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645


What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes

65

Total GBinding=
● Gas-phase molecular mechanics energy ΔEMM:

○ changes in the internal energies ΔEint (bond, angle, and 
dihedral energies)

○ electrostatic energies ΔEele

○ van der Waals energies ΔEvdW

● sum of the electrostatic solvation energy Gsol
○ The polar contribution is calculated using either the PB 

or GB model (ΔGPB/GB). Where the GB method gives an 
analytical expression for the polar solvation energy and is 
thus much faster than the PB method.

○ nonpolar energy is usually estimated using the 
solvent-accessible surface area (SASA)

● The change in conformational entropy −TΔS 
○ is usually calculated by normal-mode analysis (or 

Interaction entropy) on a set of conformational snapshots 
taken from MD simulations.
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GENERALIZED BORN:
POISSON BOLTZMANN:

MMPBSA Energy and MMGBSA 
Energy cannot be compared within the 

different methods. But you can rank 
your molecules by energies obtained 

from each method separately.
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1KE61KE5 1KE7

IC50: 560 nM
Vina: -8.7
GBSA (0.1 ns): -30.7
GBSA (1 ns): -25.8

IC50: 5.7 nM
Vina: -8.9
GBSA (0.1ns): -23.3
GBSA (1ns): -21.5

CYCLIN-DEPENDENT 
KINASE 2 (CDK2)

IC50: 8.9 nM
Vina: -9.6
GBSA (0.1ns): -19.3
GBSA (1ns): -27.1



Docking best pose
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1KE5 1KE6 1KE7



Beta Secretase
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Thank you for your attention!


